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The content of computer distribution of the second grade of prep. First term 2016-2017 

The 

week 
Subject Cooperative activities 

1 Web sites 

 The concept recognizes (website - Home / web 
page) 

  conclude that the Web site consists of one or 
more pages 

 Conclude web pages' components (text - image - 
Video - Hyperlink) 

 Recognize the concept of a static web page  

 Recognize the concept of Dynamic web page 

2 
Stages of design 
and construction 

website 

 Differentiate between the stages of design and 
construction website 

 Paint a simple outline on paper includes web 
pages 

 Design sketches for Web pages, "My school site." 

 Look for the required texts for different web 
pages. 

 Capture a series of images from his school 
classes and labs and playgrounds 

 Save images as files within a storage unit 

3 
Creating and 

processing audio 
files 

 Prepare and   equip for audio file 

 Record voice comments using Audacity program 
in the creation and processing of sound 

 Modify the audio clip to add effect 

4 
Continued creation 

and processing 
audio files 

 Adjust the sound clips (cut-and-paste / delete) 

 Put effects on one sound clips 

 Sound comes to file with appropriate (MP3 – 
Wav) 

5 
Create and 

manipulate videos 

 Import files (images / sound) using Open-shot 
program in editing and processing of video files 

 Create videos inside the video processing 
program files 

6 
Continued to create 

and manipulate 
videos 

 Adjust the video scenes 

 Save video project file 

 Add effects to scenes video 
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7 
Continued to create 

and manipulate 
videos 

 Add (transitions / text) to watch the video 

 To issue a video file with appropriate extinction.  

8 

HTML coding 
languages 

Key Concepts 

 Definition of the language HTML 

 HTML commands 

 Rules basic Web site using HTML to create a 
page 

 About the structure to create a web page using 
HTML 

 Add the title of the web page about it <title> 
….</title> 

9 

Add the content of 
the web page 

Continued 
coordination of the 

web page 

 Add text to the web page 

 Change the direction of the web page using the 
property dir 

 The beginning of the writing of a new line thing 
<br> 

 Centering text about it <center> . </center> 

10 

Continued 
coordination of the 

web page 

Background web 
page Coordination  

 Add a blank space between words matter & nbsp 

 Determine the background color of the web 
page characteristic bgcolor 

 Put a picture as the background of the web page 
characteristic background 

11 
Font format on the 

web page 

 Command <font> .. </font> to coordinate the 
Line  

 Commands <u> , <b> , <i>to change the font 
style 

12 
Add multimedia 

web page 

 insert image within a web page about it <img> 

 Control the dimensions of the image web page 
height property and property width 

 The alignment of the image within the page 
characteristic Align 

13 

Added multimedia 
web page 

hyper-link 

 The inclusion of audio sounds as a backdrop 
blight thing <bgsound> 

 Video inclusion within the page about it 
<embed> 

 insert Hyperlink text of the web page about it 
<a> .. </a> 
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 A hyperlink to the image of the inclusion of the 
Web page about it <a> .. </a> 

14 
The establishment 
of the project "My 

school site." 

 Create web page "Home" 

 Create web page "about the school." 

15 
He set up the 

project "My school 
site." 

 Create web page "photo album" 

 Creating web "contact" page 

16 
General Review - 
practical tests 

 General Review. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

I think the computer is 

difficult this year …!! 

Never...it’s very easy, 

interesting, fun and useful 

in our daily life 
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1 Chapter 

 

 

  

 

 

 

 

Basic concepts of the websites 

Website is: webpage or more which are linked together under a certain 

name, 

 Website has web address on the internet which we can visit it through 

computer or mobile using browsers, this address is called URL 

 You can open the Ministry of Education website (WWW.MOE.GOV.EG). 

Web page is: document has an electronic content published at the internet 

and displayed through browser. 

Home page is: the first page on the web site, through it you can navigate to 

all web pages, it also called the main page. 

Hyperlink is: text or picture when click on it transmit you to another place. 

By the end of this subject student should be able to: 

- Recognize the concept of (Website – webpage – homepage). 

- Distinguish the website components.  

- shows the web page elements. 

- Recognize the webpage types (static / dynamic) pages. 

 

Web sites 

http://www.moe.gov.eg/
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From the previous activity you can distinguish that the website elements may 

be (Text – pictures video -hyperlinks). 

-===========================- 

 

 

 

 

 

 

 

 

 

 

Pre-made content, this content remains constant. There 

pages used for read only pages without any procedures 

Use HTMLom users. fr 

Also called interactive page which is a page that displays 

 process it.s to interact with and the content allows user

.pup or Asp use Java script, 

Web site elements 

Web page types

Static web 
page

Dynamic 
web page

Web page types 
 

Elements of web site 1 

types of pages 1 
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A- Choose the correct answer:  

1- Page that displays the content allows users to interact with and process it.                

[Home page - Static page - Dynamic page - Web page.] 

2- webpage or more which are linked together under a certain name, 

[Web site – hyper link -internet - pages] 

3- the website elements may be…. 

[Text – pictures & video -hyperlinks - all of them] 

4- Any website must have a unique [hyper link – page -URL – computer] 

5- Any web site contains a group of [websites -Pages -papers – URL] 

B- Put [√] or [X]: 

1- Web page consists of a group of web sites.                               (          ) 

2- When you click the hyperlink it transmits you to another place. (          ) 

3- Java script and php. Used to create an interactive page.           (          ) 

4- The static page is created by HTML.                                          (          ) 

5- There is difference between home page and main page.           (         ) 

C- Complete the following: 

1- Web site is ………………………………………………………… 

2- Web page is ………………………………………………………. 

3- URL is ……………………………………………………………… 

4- Hyper link is ……………………………………………………… 

5- Dynamic page is…………………………………………………. 

 

Exercise 1 
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Design and create Web site goes through several stages can be summarized 

as follows: 

1st. Planning to build a website. 

2nd. Designing of web pages. 

3rd. Preparation and processing 

of web pages. 

4th. Implementation of web 

pages. 

5th. publish the web site online 

(on the internet). 

 

In this stage the diagram or flowchart will be drawn on paper, this flowchart 

will include the website page (Home page for site and other pages which are 

linked by it). 

Stages of design and construction Web site 

1- Planning to build a website. 

 

Home page

About School Gallary vision &message
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This step is from important stages and contains of: 

 Design the shapes of the pages. 

 Identify the different formatting (font-

background-colors …). 

 Identify the different hyperlinks in pages. 

Include some steps: 

a- Preparing of the texts. 

In this step you can determine the texts that you will use in the web pages 

(Creation date of school –school address –Tel. no -…) 

You can search for text on the internet and save it as text file. 

b- Preparing of the pictures. 

By capture some photos related the web site using mobile or digital camera, 

and save all pictures in file on your computer, note 

that you should save the pictures with appropriate 

extension such as (Gif – Png –Pmb –jpg). Recognize 

some of pictures types. 

c- Preparing of the videos. 

By capture some videos using mobile or digital camera 

related the web site, and save all videos in file on your 

computer with appropriate extension. 

 

 

 

1- Convert the previous stages into website. 

2- Insert data into website. 

3- Create hyperlinks. Using HTML commands. 

It is to book the web address (URL) for the 

website and allocate storage on the server 

devices. 

 

 

4- Implementation of web pages  

2- Designing of web pages. 

3- Preparation and processing of web pages 

5- Publishing the website on the internet 

The suggested website 
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A-  Put (√) or (X): 

1- The first step of create a web site is planning.                              (          ) 

2- You should draw flow chart for your site before create it.             (          ) 

3- No need to collect data about the web site subject.                     (          ) 

4- [Mp3] is an extension of pictures.                                                 (          ) 

5- Publishing & booking storage is the second stage of creation a web site. (  

 

B- Re-arrange the following: 

1st: Implementation of web pages.                           (            ) 

2nd. publish the web site online (on the internet).    (            ) 

3rd: Preparation and processing of web pages.       (            ) 

4th: Planning to build a website.                               (            ) 

5th: Designing of web pages.                                   (            ) 

 

C- Complete the following: 

The implementation of create web site is passing on:  

 

1- …………………………….. 

2- …………………………….. 

3- …………………………….. 

 

 

 

 

 

 

 

 

 

  

Exercise 2 
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Lesson 3    

 

 

 

:Objectives 

 Recognize programs of creating and processing sound 

 Prepare data and programming component to create sound 

 Use Audacity program to create and edit sound. 

 Insert effects to sound and know sound extensions. 

 There are several programs to create and process sound through group of tools that 

help user. 

You can create sound contains the required audio parts and add effects on it and 

save it inside file by using Audacity program. 

First, stage of prepare and processing to create an audio file: 

1- preparing and processing collected data about the school or the subject of 

Web Design, such as school educational administration name, Governorate 

name, competitions carried out jointly by the school, centers obtained by the 

school competitions certificates of appreciation, classroom activities, school 

trips and then writing the data in coordinators texts and save it within the text 

file. 

2- Setup and processing software 

Install a creation programs and audio processing on the computer, such as 

Audacity. 

3- Setup and processing hardware 

Connect the microphone and speakers or headset to the computer. 

Second, implementation stage to create a sound file: 

1- Download the software and create audio processing: Download Audacity is 

one of the open source software and it works on operating systems such as 

Linux - Windows through the link, /.Sourceforge.nethttp://audacity. 

Creating and processing the Sound files 
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The opening screen: 

2- Audio recording: 

a- Press Record button  

b- Read data that is saved to a text file 

using the mic. 

c- Finish the record by click on stop. 

d- Click on Play to listen to sound. 

Third, the amendment in the sound: 

 Add an effect on the audio clip: 

1- Playback Audio by clicking the play button, and listen to it. 

2- Determine the required sound clip added influence to it by clicking and dragging on 

the desired sound, using the mouse pointer on the timeline tap. 

 
3- From Effect menu select an effect such as Repeat or Reverse. 

4- Re-play the sound again after adding effect. 

Cut and paste Audio clip: 
- Select the audio clip 

- Open Edit menu and select Cut. 

-  Using the mouse pointer on the timeline tap to paste. 

- Open Edit menu and select paste. 

 

 

 

 

                                 

Or 

you can use this tap  

 Delete sound clip: 

- Select the sound part 

- Press on Delete key from Keyboard. 
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Fourth, Export the audio file: 

- From the File menu chose Export Audio. 

- Select the place and select the appropriate extension of the audio file and write 

the name of the file. 

- write information about the file, and then click OK 

 

 

Types of extensions audio files: 

There are different types of the extension of the sound, such as MP3 and WAV 

they differ in the quality and purity of sound and space storage and 

identification of extension type. 

- Audio file with extension WAV is characterized by quality and clarity and has 

large storage capacity, which is not suitable for publish on Web sites 

- Audio file with extension Mp3 purity is less compared to a WAV extension, has 

small storage capacity, most commonly use on websites. 
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A- Choose the correct Answer: 
1- ……………………program Is Used To create and process audio file  

(Open shot -Audacity-Movie maker -windows) 

2- To record sound, you have to connect the ……with a computer 

(Microphone – Printer – Speakers -Headset) 

3- This icon is used to ……. sound 

(Play -stop – cut – record) 

4- This icon is used to……. sound 

(Cut – copy - paste -  Delete) 

5- To add influence to sound, you have to select the effect from …. menu 

(File– Effect – Edit – Help) 

B- Put (√) or (X): 
 

1- You can select Export sound from Edit menu.                    (             ) 

2- PNG. and Mp4 are from audio types.                                  (             ) 

3- The Extension WAV is larger capacity than Mp3.               (             )  

4- Mp3 type is most commonly in websites.                            (             ) 

5- WAV type is not suitable for publish on Web sites.             (             ) 

C- Complete the following: To create an audio sound: 

First -       ……………………………………………………….. 

Second - ………………………………………………………… 

Third-      ………………………………………………………… 

Fourth - ………………………………………………………… 

 

 

 

Exercise 3 
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Lesson 4    

 

:Objectives 

 Recognize programs of processing Video 

 Prepare data and programming component to create video. 

 Import files (Images/Audio) to open shot to create video. 

 Edit video clip and save it. 

 Add effects to video clip and know video extensions. 

Create and video processing programs are those programs that enables the user to 

create and edit video files through they contain several tools and the means and the 

influences that help the user in the creation and processing of video clips a quick 

and easy way, including the Open shot program is open source software and runs on 

the Linux operating system and windows operating system there are other programs 

such as Movie Maker. 

Download the creation and processing of video and identify the interface: 

You can download open shot program through the link www://.openshot.org 

The features of Open shot: 

1- We can produce high quality video from images, backgrounds and 

audio. 

2- Program interface is Easy. 

3- Add effects and transitions between images Breaks. 

4- Adding texts. 

 

Creating and processing the video files 
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The components of the open shot program welcome screen: 

1- Main toolbar. 

2- Project files. 

3- Function tab to transmit between project files (pictures / sounds /video). 

4- Window preview. 

5- Edit toolbar. 

6- Zoom slider. 

7- Play head / Ruler. 

8- Timeline. 

The timeline of program: 

1- Ruler to show the time. 

2- Play head to read current 

clip in timeline to preview 

within displaying window. 

3- The current clip is video, 

sound or pictures. 

4- Tracks like layers  

The image, voice or video 

clip are put on the track 

And can be used an unlimited number of tracks to the project and it must 

be noted that the top priority is to track. 
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Steps to create video clip: 

First: download the open shot program and import the images files. 

Through pressing on import button or file menu select import to be 

shown within project files of the program. 

 

Second: Arrange the images on the timeline: 

Click and drag on pictures in project files to put each picture ordered in 

track as you want. 

 

 

Third: Import sound files within program. 

To make the video more attractive and effective by adding music or audio 

commentary. 

You can import sound by clicking on   then select sound and drag it to 

track in the timeline. 
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Fourth: Video preview. 

Click on play button  to preview the video before finishing it. 

 

Save video project: 

 You can save all project files within certain folder. 

 From file menu select save project As  

 Name the project and select place that you want to save in it. 

 You can open the project again by select open from file menu. 

Edit video clip: 

First: Control in the time period to display video clip: 
When preview the video (consist of sound and pictures) the time of sound 

may be more than displaying of pictures. To stop sound to be suitable with 

pictures through the following: 

1- Move the pointer until reach to the last space on timeline to finish with 

the last picture. 

2- Right click on the timeline. 

3- From shortcut menu select slice clip then click on the selections. 

a-  Keep left slide. 

b- Keep both slides. 

c- Keep right slide. 

 



 

. Termst1                                           Computer & Information TechnologyPrep.2                                      

 

- 19 - 
 

Second: Add effects to video clip: 
1- Click on Effects tab. 

2- Select one effect by click and drag and drop on the timeline and 

preview the video clip. 

Third: Add transitions to video clip: 
1- Click on transitions tab. 

2- Click with drag and drop in timeline between pictures. 
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Fourth: Add text to video clip:  

After identifying the required text which you want to add to video: 

From Title menu select Title the dialogue box will appear: 
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Export the video to file with appropriate extension: 

After the completion of the project and put all the video clip and adjustments, 

effects and transitions, we export the video file with appropriate extension: 

1- Click on export video button    in the main menu or File menu. 

2- Write video name and select the location which you will save in 

it "path". 

3- Select video extension or video type of video. 

4- Identify the quality of video. 

5- Press on Export button and run the video to display it. 

 

Types with different extensions of video files: 

1- AVI: large size, High quality, suitable with computers and cameras.  

2- MP4: Average size, Video image clarity in the medium, medium in quality. 

3- 3gp: smallest type in size, less quality, suitable with old mobiles. 
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A- Choose the correct Answer: 
1- ……………………program Is Used to create and process video file  

(Open shot -Audacity-Movie maker -windows) 

2-  This icon is to………. Files. (Export – open -Import – Exit) 
3- …….is consisted of tracks. (video – Sound – Timeline – track) 
4- To save project select save as from…menu. (Edit – Import – View – File) 
5- The best type of video is……. (Mp3 – Mp4 -AVI -3GP) 

 

B- Look at the picture, then complete the following: 

1- ………………….. 

2- ………………….. 

3- ………………….. 

4- ………………….. 

5- ………………….. 

6- ………………….. 

7- ………………….. 

8- ………………….. 

C- Put (√) or (X): 
1- We can produce high quality video from images and audio. 

2- Open shot doesn't allow to add transitions between video. 

3- You can insert pictures to timeline through drag and drop. 

4- The text which inserted

5-  to video appears in the beginning only. 

6- Mp4 is larger size than AVI. 

D- Compare between the following: 

Type size quality using 

AVI    

MP4    

3gp    

Exercise 4 
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Chapter 2 

Create a website using HTML 
Lesson 1: 

 

 

 

With HTML you can create your own Web site. 

HTML is easy to learn - You will enjoy it. 

 

HTML is markup Language: 

It’s a coding language used to create the static websites which are 

displayed by internet browsers. 

The HTML orders: 

HTML stands for Hyper Text Markup Language 

A markup language is a set of markup tags 

HTML documents are described by HTML tags 

Each HTML tag describes different document content 

The internet browsers understand and perform them. 

 

HTML 

(Hyper Text Markup Language) 
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To learn more about HTML, you should visit this website: 
http://www.w3schools.com/html 

For Example: 

Example Explained 

The text between <html> and </html> describes an HTML document 

The text between <head> and </head> provides information about the 

document 

The text between <title> and </title> provides a title for the document 

The text between <body> and </body> describes the visible page content 

The text between <h1> and </h1> describes a heading 

The text between <p> and </p> describes a paragraph 

Using this description, a web browser will display a document with a heading 

and a paragraph. 

HTML tags are keywords (tag names) surrounded by angle brackets: 

<Tag name>content goes here...</tag name> 

HTML tags normally come in pairs like <p> and </p> 

The first tag in a pair is the start tag, the second tag is the end tag 

The end tag is written like the start tag, but with a forward slash inserted 

before the tag name 

The start tag is also called the opening tag, and the end tag the closing tag. 

It is not required to write the tags neither capital letters nor small. 

The purpose of a web browser (Chrome, IE, Firefox, Safari) is to read HTML 

documents and display them. 

 

http://www.w3schools.com/html
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The basic constructive to create a webpage using HTML: 

Follow the four steps below to create your first web page with Notepad. 

Step 1: Open Notepad (PC) 

Step 2: Write Some HTML 

a- Head: has special information about the 

page, such as page title. 

b- Body: writing area specific for the content 

that appears within the page. 

Step 3: Save the HTML Page 

Save the file on your computer. Select File 

Then Save as in the Notepad menu 

Name the file "indexl.htm" and set 

the encoding to UTF-8 (which is the 

preferred encoding for HTML files) 

You can use either .htm or html as file 

extension. There is no difference. 

Step 4: View the HTML Page in Your 

Browser 

Open the saved HTML 

file in your favorite 

browser (double click 

on the file, or right-

click - and choose 

"Open with") The 

result will look much 

like this: 
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 EX. 

The Html Code The result 

 

 

 

Note that; the result is not affected by the Enter key to begin a new line. 

The main rule to change properties for the webpage: 

 
Ex.     <body dir="rtl"> 

 Change page direction using attribute dir: 

Dir is property used to change the page direction Left to Right or Right to Left. 

The attribute The value Effect 

Dir Rtl change the page direction Right to left 

ltr change the page direction Left to Right 
 

Code Result 
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A- Choose the correct answer: 

1- You can create ………………. web page using HTML. 

(dynamic – reactive – static – database) 

2- The html commands are called ……… (codes – orders – text – tags). 

3- …….is used to write the html tags in it. (Notepad – Audacity – Excel – Mac) 

4- ………… is to read HTML documents and display them. 

(web page -web browser – audio processing – open shot) 

5- The html document must begin with ………and end with the same with /. 

(<body> - <title> - </html> - <html>). 

B-  Put (√) or (X): 
 

1- Html is a markup language and easy to learn.                                (          ) 

2- The text between <body>and</body> describes the page title.      (          ) 

3- Internet explorer is considered a web browser.                               (          ) 

4-  </html> is the start tag.                                                                    (          ) 

5- The extension of webpage that is created by html is "htm or html". (          ) 

 

C- Match the following with the suitable: 
 

A B 

1-  <title> …. </title>  change the page direction Right to left 

2-  HTML  change the page direction Left to Right 

3-  Rtl  describes the visible page content 

4-  <body> ...</body>  provides a title for the document 

5-  ltr  Stands for Hyper Text Markup Language 
 

 

 

 

 

 

 

Exercise 5 
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HTML elements with no content are called empty elements 

 The <br> tag defines a line break or to begin new line. 

The <Center> tag is used to align text in the center of page. 

The &nbsp; to insert space between words 

 such as example 

the code 

The result 

 
 

 The Font Formatting <Font> …</Font>: 

The font has some attributes: 

Note: Browser identifies seven different 

sizes fonts is determined by the size 

property. 

Attribute Function 

Face Change font type 

Color Change font color 

Size Change font size 

The webpage formatting 
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Steps to change font type "Arial" and font color red and font size 6: 

 Open the previous Notepad file. 

 Type the code <Font face ="Arial" color="red" size="6"> as shown in 

example: 

 

 
 

HTML uses elements like <b> and <i> for formatting output, like bold or italic. 

Formatting elements were designed to display special types of text: 

<b> Bold text 

<i> Italic text 

<u> underline text 

<small> Small text 
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Background Formatting: 
1- Identify a color as background color for the page. 

bgcolor property of the body element is used to change the background 

color of the webpage page. 

EX. 

<Body bgcolor="Green"> to make the background color green. 

The following table show the colors name as value for the property bgcolor:  

2- Identify a picture as background for the page. 

Background property of the body element is used to change the 

background image of the webpage page. 

Ex. 

<body background="School.png"> 
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Add multimedia to web page 
Insert picture in the webpage and dealing with it: 

You can insert a picture in the page using the attribute SCR which followed 

the element IMG. 

This insertion of picture requires identifying the name, the location and the 

extension of picture. 

To know the name and location of picture you can right click on the picture 

icon and select properties from shortcut menu. 

Write the following code in Notepad file: 

<Img src ="image.png"> 

Then save the file and preview in browser you will see the picture in the page. 

 Control in the picture dimensions:  

Through the element img attributes you can control in the dimensions of the 

picture ===Height & Width the measurement unit of picture dimensions is 

Pixel. write this code: <img src="image.png" height="250" width="500"> 
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Alignment of picture 

You can control in picture alignment (right - center – left) through the 

attribute align of the element img and take the following values: 

Attribute value function 

Right Align image to page right 

Left Align image to page left 

Middle Align image to page center 

Bottom Align image to page bottom 

Top Align image in top of page 

<img src="image.png" align="left"> 

Insertion sound as background for the webpage: 

We can insert audio file to be a background of the page during loading. 

Using the tag <bgsound> 

Important note: Internet Explorer is only browser that supports the 

implementation of the tag <bgsound> and src attribute as shown in code: 

<bgsound src="Sound.mp3"> 

  

Insertion Video clip in the webpage: 
Using the tag <Embed>, this tag supports 

the video types (AVI, MOV, and MP4) 

<Embed src="Video.Mp4"> 
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Insert Hyperlink in the webpage: 
Links are found in nearly all web pages.  

Links allow users to click their way from page to page. 

HTML links are hyperlinks. 

You can click on a link and jump to another document. 

Note: A link does not have to be text. It can be an image or any other HTML 

element. 

In HTML, links are defined with the <a> tag and its attribute href: 

<a href="The address to move to it"> the text or picture that clicked </a> 

Insert text as hyperlink: 

 

 
Insert picture as hyperlink: 

<a herf=" http://alkhalilschools.net/"> <img src="image.png"></a> 

 

http://alkhalilschools.net/%22%3e%20%3cimg
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Summary of all HTML tags: 

Tag The function Attributes 

<html> describes an HTML document  

<head> provides information about the document  

<body> describes the visible page content Dir – bgcolor-
background 

<title> provides a title for the document or page  

<br> To begin anew line or break  

<h1> describes a heading  

<p> describes a paragraph  

<center> Make text in the page center  

&nbsp Take a space between words  

<font> Font formatting Face – color – 
size 

<u> Underline text  

<i> Italic text  

<b> Bold text  

<img> Insert image within webpage Src-height-width-
align 

<embed> Insert sound or video within page Src 

<bgsound> Insert sound as background in page Src 

<a> Create a hyperlink in page Href 
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A – Write the implementation of these tags: 

The code The result 

1-  <title>My School</title>  

2-  <Font color=”red”>Computer</font>  

3-  <img src="image.png" align="left">  

4-  <br>  

5-  <Body bgcolor=”green”>  

6-  <font size=”5”>  

7-  <bgsound src=”Egypt.mp3>  

8-  <embed src=”video.Mp4”>  

9-  <a href=”www.google.com”>click</a>  

 B- Choose the correct answer: 

1- You have to save the html document with the extension…… 

(doc – Avi –htm - Mp3) 

2- To make the text appears on the webpage as Italic use the tag: 

(<u> - <b> - <i> - <br>) 

3- To identify the background color use the attribute… 

(Background – bgcolor – color-background color) 

4- The attribute which linked with the tag <img> is.. 

(Path – herf – htm – src) 

5- The tag <a> is used to ……….within the webpage. 

(Align text – insert a hyperlink – play video – add image) 

6- The attribute ……..is used to identify the font type in <font> tag. 

(Type – font name- face – size) 

C-.put (√) or (X): 

1- Using the tag <title> to indicate that the document have written by html. (    )  

2- To control in the number of spaces between words us &nbsp;                (    ) 

3- To add a picture use the tag <img>                                                          (     ) 

4- <img href=”image.png > is a right code.                                                   (     ) 

5- The picture should be in the same folder with the page to be added.      (     ) 

Exercise 6 

http://www.google.com/
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Chapter 3 

Projects 

 

 

 

At the beginning you have to create a new folder for project data collection 

which contains (webpages, pictures, sound, video and all project files). 

The components of the website: 

1- Home page for my school website "home.htm". 

2- About school page "about.htm". 

3- Page includes the photo albums "gallery.htm". 

4- Page for school vision and message "vision.htm" 

Each page will be written separately in Notepad file with HTML tags. 

First: Create the Home page 

 

Create a project "My School" website 
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  The result 
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Second: Create about school page: 
This page is consisted of - text (creation date –school address –tel. number) 

 Video illustrate the school attractions. 

 Picture as a hyperlink to the home page. 
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Third: Create Gallery page: 

 

 
 

Fourth: Create vision and message page: 
This page consists of  

 Text 

 Background 

 Video 

 Hyperlinks 
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Remember that:  
Website is: webpage or more which are linked together 

under a certain name, 

 Website has web address on the internet which we can visit it through 

computer or mobile using browsers, this address is called URL 

Web page is: document has an electronic content published at the internet 

and displayed through browser. 

Home page is: the first page on the web site, through it you can navigate to 

all web pages, it also called the main page. 

Hyperlink is: text or picture when click on it transmit you to another place. 

Static webpage: 

Pre-made content, this content remains constant. There pages used for read 

.Use HTML only pages without any procedures from users. 

Dynamic webpage: 

Also called interactive page which is a page that displays the content allows 

Use Java script, pup or Asp.users to interact with and process it.  

Design and create Web site goes through several stages: 

1st. Planning to build a website. 

2nd. Designing of web pages. 

3rd. Preparation and processing of web pages.  

4th. Implementation of web pages. 

5th. publish the web site online (on the internet). 

To create an audio file, follow the steps: 

1- Preparation and processing: 

 Collect the data which will be recorded in file. 

 Setup an audio processing software "Audacity" 

 Connect the mic with the computer 

2- Implementation of creation an audio file: 

 Start to record sound by clicking on record button. 

 Using the microphone to talk. 

 After finishing click on stop button and play again to listen to the sound. 
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3- Editing the audio file: 

 Add an effect to the sound. 

 Cut, copy and paste an audio clip. 

 Delete a part from audio file. 

4- Export the audio file with the appropriate extension. 

 WAV is characterized by quality and clarity and has large storage capacity, 

which is not suitable for publish on Web sites 

 Mp3 purity is less compared to a WAV extension, has small storage capacity, 

most commonly use on websites. 

To create a video clip, follow the steps: 

1- Import the pictures and audio files with in the open shot program. 

2- Order the pictures and the sound on the timeline of the program. 

Save the video project: 

- Create a folder for the project. 

- Put all files that will be used in the folder. 

- Save the project from file menu, select save project as. 

Edit video clip: 

- Control in the time period which specific by displaying the video clip. 

- Add an effect to video from effect menu. 

- Add transition between pictures from transition menu. 

Add a text to the video: 

- From title menu select title and write the text. 

- Save the file text in folder. 

- The text file will be displayed in the project files.  

- Drag the file and drop it the time line. 

Export the video clip: From the file menu or export button you can export the 

video with the suitable extension: 

 AVI: large size, High quality, suitable with computers and cameras.  

 MP4: Average size, Video image clarity in the medium, medium in quality. 

 3gp: smallest type in size, less quality, suitable with old mobiles. 

HTML is markup Language: It’s a language used to create the static 

websites which are displayed by internet browsers. 
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HTML stands for Hyper Text Markup Language 

A markup language is a set of markup tags 

HTML documents are described by HTML tags 

Each HTML tag describes different document content 

The internet browsers understand and perform them. 

Use java script or php language to create a dynamic webpage. 

Step 1: Open Notepad (PC) 

Step 2: Write Some HTML 

Step 3: Save the HTML Page 

Step 4: View the HTML Page in Your Browser 

Tag The function Attributes 

<html> describes an HTML document  

<head> provides information about the document  

<body> describes the visible page content Dir – bgcolor-
background 

<title> provides a title for the document or page  

<br> To begin anew line or break  

<h1> describes a heading  

<p> describes a paragraph  

<center> Make text in the page center  

&nbsp Take a space between words  

<font> Font formatting Face – color – 
size 

<u> Underline text  

<i> Italic text  

<b> Bold text  

<img> Insert image within webpage Src-height-width-
align 

<embed> Insert sound or video within page Src 

<bgsound> Insert sound as background in page Src 

<a> Create a hyperlink in page Href 
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General Revision 
Q1- Choose the correct answer:  

1- Page that displays the content allows users to interact with and process it.                

[Home page - Static page - Dynamic page - Web page.] 

2- webpage or more which are linked together under a certain name, 

[Web site – hyper link -internet - pages] 

3- the website elements may be… 

[Text – pictures & video -hyperlinks - all of them] 

4- Any website must have a unique [hyper link – page -URL – computer] 

5- Any web site contains a group of [websites -Pages -papers – URL] 

6- ……………………program Is Used to create and process audio file  

(Open shot -Audacity-Movie maker -windows) 

7- To record sound, you have to connect the ……with a computer 

(Microphone – Printer – Speakers -Headset) 

8- This icon is used to ……. sound (Play -stop – cut – record) 

9- This icon is used to……. sound (Cut – copy - paste -  Delete) 

10- To add influence to sound, you have to select the effects from …. menu 

(File– Effect – Edit – Help) 

11- ……………………program Is Used to create and process video file  

(Open shot -Audacity-Movie maker -windows) 

12-  This icon is to………. Files. (Export – open -Import – Exit) 
13- …….is consisted of tracks. (video – Sound – Timeline – track) 

14- To save project select save as from…menu. (Edit – Import – View – File) 

15- The best type of video is……. (Mp3 – Mp4 -AVI -3GP) 

16- ……………program Is Used to create and process video file. 

(Open shot -Audacity-Movie maker -windows) 

17- You can create ………………. web page using HTML. 

(dynamic – reactive – static – database) 

18- The html commands are called ……… (codes – orders – text – tags). 

19- ..is used to write the html tags in it. (Notepad – Audacity – Excel – Mac) 
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20- ………… is to read HTML documents and display them. 

(web page -web browser – audio processing – open shot) 

21- The html document must begin with …and end with the same with /. 

(<body> - <title> - </html> - <html>). 

22- You have to save the html document with the extension…… 

(doc – Avi –htm - Mp3) 

23- To make the text appears on the webpage as Italic use the tag: 

(<u> - <b> - <i> - <br>) 

24- To identify the background color, use the attribute… 

(Background – bgcolor – color-background color) 

25- The attribute which linked with the tag <img> is.. 

(Path – herf – htm – src) 

26- The tag <a> is used to ………. within the webpage. 

(Align text – insert a hyperlink – play video – add image) 

27- The attribute …….is used to identify the font type in <font> tag. 

(Type – font name- face – size) 

Q2- Put [√] or [X]: 

1- Web page consists of a group of web sites.                               (          ) 

2- When you click the hyperlink it transmits you to another place. (          ) 

3- Java script and php. Used to create an interactive page.           (          ) 

4- The static page is created by HTML.                                          (          ) 

5- There is difference between home page and main page.           (         ) 

6- The first step of create a web site is planning.                            (          ) 

7- You should draw flow chart for your site before create it.           (          ) 

8- No need to collect data about the web site subject.                    (          ) 

9- [Mp3] is an extension of pictures.                                                (          ) 

10- Publishing & booking storage is the second stage of creation a web site. (    ) 

11- You can select Export sound from Edit menu.                           (         ) 

12- PNG. and Mp4 are from audio types.                                        (          ) 

13- The Extension WAV is larger capacity than Mp3.                     (           )  

14- Mp3 type is most commonly in websites.                                  (           ) 

15- WAV type is not suitable for publish on Web sites.                   (           ) 
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16- We can produce high quality video from images and audio.     (           ) 

17- Open shot doesn't allow to add transitions between video.      (           ) 

18- You can insert pictures to timeline through drag and drop.       (          ) 

19- The text which inserted to video appears in the beginning only. (         ) 

20- Mp4 is larger size than AVI.                                                        (           ) 

21- Html is a markup language and easy to learn.                            (          ) 

22- The text between <body>and</body> describes the page title.      (          ) 

23- Internet explorer is considered a web browser.                               (          ) 

24-  </html> is the start tag.                                                                    (          ) 

25- The extension of webpage that is created by html is "htm or html". (          ) 

28- Using the tag <title> to indicate that the document has written by html.(    )  

29- To control in the number of spaces between words us &nbsp;           (    ) 

30- To add a picture use the tag <img>                                                         (     ) 

31- <img href=”image.png > is a right code.                                                  (     ) 

32- The picture should be in the same folder with the page to be added.  (     ) 

Q3 - link between each of the following: 

1- Web site  pages used for read only without any procedures 
from users and created by HTML 

2- Web page  Webpage or more which are linked together under 
a certain name. 

3- Home page  document has an electronic content published at 
the internet and displayed through browser. 

4- Static page The first page on the web site, through it you can 
navigate to all web pages, it also called the main 
page. 

5- Dynamic page page that displays the content allows users to 
interact with and process it. Created by Java 
script, pup or Asp. 
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A B 
1-  <title> …. </title>  change the page direction Right to left 

2-  HTML  change the page direction Left to Right 

3-  Rtl  describes the visible page content 

4-  <body> ...</body>  provides a title for the document 

5-  ltr  Stands for Hyper Text Markup 
Language 
 

 

 

Q 4 - Re-arrange the following: 

A- to design a web site: 

(       )  Implementation of web pages.                            

(       )  publish the web site online (on the internet).     

(       )  Preparation and processing of web pages.        

(       )  Planning to build a website.                                

(       )  Designing of web pages. 

B-To create an audio sound: 

First -       ………………………………………………………..  

Second - ………………………………………………………… 

Third-      ………………………………………………………… 

Fourth - ………………………………………………………… 

A B 

Mp3 Extension of webpages that created with html 

AVI Extension of pictures 

Mp4 From an audio extensions and most commonly use on 

websites 

Html Average size, medium in quality video. 

png large size and high quality of video 
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E- Look at the picture, then complete the following: 

 
1- ………………….. 

2- ………………….. 

3- ………………….. 

4- ………………….. 

5- ………………….. 

6- ………………….. 

7- ………………….. 

8- ………………….. 

 

 

A – Write the implementation of these tags:  

 

The code The result 

1-  <title>My School</title>  

2-  <Font color=”red”>Computer</font>  

3-  <img src="image.png" align="left">  

4-  <br>  

5-  <Body bgcolor=”green”>  

6-  <font size=”5”>  

7-  <bgsound src=”Egypt.mp3>  

8-  <embed src=”video.Mp4”>  

9-  <a href=”www.google.com”>click</a>  

http://www.google.com/

